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RECALIBRATION
Your Alicat instrument is a precision device and Alicat strongly 
recommends that you send it to us on a yearly basis for recalibration. 

A yearly recalibration does a few things: 

►► It insures that your unit is functioning according to specification. 

►► Contamination may cause the instrument to measure flow 
improperly. Recalibration insures the instrument is clean and free 
from debris.

►► Recalibration maintains your LIFETIME WARRANTY!

Sending your unit for recalibration is easy and inexpensive. Recalibrations 
are usually shipped within five days of receipt, so it’s fast too.

Please keep the original box to return your Alicat instrument for recalibration.

For more information regarding recalibration see page 40.

ACCESSORIES
Now that you have your Alicat instrument are you sure you’ve got 
everything you need? Alicat accessories can make your job easier.

Many of our customers also order:

►► Power Supplies — A universal wall power supply that makes it easy 
to power your Alicat unit just about anywhere in the world.

►► BB9 — Alicat’s multi-drop box that allows easy connection of up to 
nine Alicat instruments to a single USB, RS-232 port.

►► MD8DB9 — An RS-232 to 8 pin Mini-DIN cable to connect your 
Alicat instrument to a computer. A variety of other cables are also 
available.

►► Flow Vision™ SC — A GUI based Windows®program that allows easy 
computer access and control for one or multiple Alicat instruments.

►► Fittings and filters — Keep your instrument properly connected to 
your process and free from harmful contamination.

See  pages 42 - 44 for a complete description and list of Alicat accessories.

FULL TECHNICAL SUPPORT | LIFETIME WARRANTY
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Thank you for purchasing an Alicat Scientific Portable Calibration Unit (PCU). 

Please take the time to find and read the information contained in this manual. This 
will help to ensure that you get the best possible service from your instrument.

The Alicat Scientific Portable Calibration Unit (PCU) is designed to accurately 
measure gas flow rates of common gases with three separate flow meters with 
ranges determined by your needs. 

The laminar flow, differential pressure flow meters housed in the PCU are 
accurate and exceptionally repeatable devices, making the PCU an excellent 
portable secondary standard for field flow meter calibration. 

The PCU’s three separate displays allow you to monitor Mass Flow Rate, 
Absolute Pressure, Volumetric Flow Rate, and Temperature simultaneously. The 
PCU is also equipped with an RS-232 output port that can be connected to a 
computer or other data-logging device. 

The Alicat PCU is designed for CLEAN, DRY, NON-CORROSIVE gases.

Please contact Alicat at 1-888-290-6060 or info@alicat.com if you have 
any questions regarding the use or operation of this device.

You can find a number of instructional videos related to the 
operation of this device by visiting the Alicat web site or scanning 
the QR code below.
http://www.alicat.com/support/instructional-videos/
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CONNECTING THE PCU
The inlet and outlet connections to the PCU are located below the displays for 
their respective flow ranges. 
Inlet connections are located on the left and the outlet connections are located 
on the right (see page 6) 
The connections are either 1/8”, 1/4”, 3/8” or 1/2” push-connect style tubing 
fittings with each fitting corresponding to a single flow range. 
Use appropriately sized plastic tubing to connect the flow source to the 
corresponding inlet fitting. 
If necessary, connect the corresponding outlet fitting to the original source 
destination with proper tubing. 

CAUTION: Push-connect fittings are easy to use, as no special tools are 
required to make the joints. However, special attention must be paid when 
cutting the tube — as the O-ring inside of the fittings can easily be damaged.

It is essential to use the correct cutter such as a pipe slice for copper pipe or 
dedicated plastic pipe cutters for plastic tube — Do not use a saw because any 
burrs left on the tube can damage the O-ring and cause the joint to leak! 

Cut your tube to the required length using the dedicated plastic pipe cutters, 
making sure you have a straight cut with no burrs. Then push the tubing 
carefully into the fitting on the bulkhead panel. 
Softer polyurethane tubing will work best, as opposed to some of the harder 
plastic tubings available. It decreases the chances of damaging the O-rings. 

If the outlet fittings are not connected to your piping, the gas 
being measured will vent to atmosphere at the outlet fittings! 

Use protective eyewear! 

Never Vent Flammable Gases To Atmosphere!
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POWER
The PCU is designed to operate on either two 9 Volt Alkaline batteries or via 
a 9-20 Vdc power supply running at a minimum 150 mA. The batteries will 
operate the PCU for about 8 hours under normal usage.
If the batteries drop below 7 volts, the low battery light will come on and the 
batteries should be replaced or alternate power should be applied. 
When the replace battery light is on the accuracy of the meters’ readings 
cannot be guaranteed.

PRESSURE
Maximum operating line pressure for PCUs with M-Series units is 145 psig (1 MPa).
If the line pressure is higher than 145 psig (1 MPa), use a pressure regulator 
upstream from the flow meter to reduce the pressure to 145 psig (1 MPa) or less.
Maximum operating line pressure for PCUs with WHISPER units is 50 psig.

Exceeding the maximum specified line pressure may cause permanent 
damage to the solid-state differential pressure sensor.

Do Not subject an M-Series Differential Pressure sensor to 
upstream-downstream pressure differentials exceeding 75 PSID.
Do Not subject a WHISPER Differential Pressure sensor to 
upstream-downstream pressure differentials exceeding 15 PSID. 

While high static pressure will typically not damage the dp sensor, sudden 
pressure “spikes” can result in complete failure of the sensor. 
A common cause of this problem is instantaneous application of 
high‑pressure gas as from a snap acting solenoid valve either upstream 
or downstream of the meter. If you suspect that your pressure sensor is 
damaged please discontinue use of the meter and contact Alicat.
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PEAK
+0.0

MENU/
MAIN

SCCM
+0.0

TOTAL/ 
TIMER

Totalizer (option only)

BACK RESET

#C
+21.50

+0.000
     CCM

MENU/
TOTAL 

TARE V PSIA
+13.60

+0.000
   SCCM

SCCM
Air+0.00

The Main display shows pressure, 
temperature, volumetric flow and mass 
flow.
Pressing the button adjacent to a 
parameter will make that parameter 
the primary display unit.
By hitting the MENU button at the 
bottom right of the screen you will 
enter the Select Menu display. 

If your meter was ordered with the 
Totalizer option (page 41), pushing the 
TOTAL button once will bring up the 
Totalizing Mode display. Pushing MENU 
will bring up the Select Menu display.

DISPLAYS AND MENUS
The device screen defaults to Main display as soon as power is applied to the meter.

Select Menu
From Select Menu you can change 
the selected gas, interact with 
your RS-232 settings or read 
manufacturer’s data. 
Push MAIN to return to the Main display.

RS232 
COMM

MFG
DATA

MAIN

MISC

GAS
SELECT

Select Menu

Main

00123.45
Scm3

2:05 h:m:s
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MAIN 
This mode defaults on power up, with 
mass flow as the primary displayed 
parameter. 
The following parameters are displayed in 
the Main mode.

Gas Absolute Pressure: This sensor 
references hard vacuum and reads 
incoming pressure both above and below 
local atmospheric pressure. This parameter 
is moved to the primary display by pushing 
the button above PSIA. 
The engineering unit associated with 
absolute pressure is pounds per square 

inch absolute (psia). This can be converted to gage pressure (psig) by subtracting 
local atmospheric pressure from the absolute pressure reading:

PSIG = PSIA – (Local Atmospheric Pressure)

Gas Temperature: M-Series flow meters 
measure the incoming temperature of the 
gas flow. The temperature is displayed 
in degrees Celsius (°C). This parameter is 
moved to the primary display by pushing 
the button above °C. 
Pushing the button again allows you to 
select 0C (Celsius), K (Kelvin), 0F (Fahrenheit) 
or 0R (Rankine) for the temperature scale. 
To select a temperature scale, use the UP 
and DOWN buttons to position the arrow in 
front of the desired scale. 
Press SET to record your selection and return 

to the MAIN display. The selected temperature scale will be displayed on the screen.

Tare: Pushing the TARE V button tares the flow meter and provides it with a 
reference point for zero flow. This is an important step in obtaining accurate 
measurements. It is best to zero the flow meter each time it is powered up. If 
the flow reading varies significantly from zero after an initial tare, give the unit a 
minute or so to warm up and re-zero it.
If possible, zero the unit near the expected operating pressure by positively blocking 
the flow downstream of the flow meter prior to pushing the TARE button. 

Zeroing the unit while there is any flow will directly affect the accuracy 
by providing a false zero point. If in doubt about whether a zero flow 

condition exists, remove the unit from the line and positively block both ports 
before pressing the TARE button. If the unit reads a significant negative value 

#C
+21.50

+0.000
CCM

MENU/
TOTAL

TARE VPSIA
+13.60

+0.000
SCCM

DOWN

CANCEL SET

MODE

  >#C
    K
    #F
    #R
   

UP

SCCM
Air+0.00

Mass Flow
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when removed from the line and blocked, it was given a false zero. It is better 
to zero the unit at atmospheric pressure and a confirmed no flow condition 
than to give it a false zero under line pressure.

Volumetric Flow Rate: This parameter is located in the lower left of the display. 
It is moved to the primary display by pushing the button below CCM in this 
example. Your display may show a different unit of measure.
Mass Flow Rate: The mass flow rate is the volumetric flow rate corrected to a 
standard temperature and pressure (typically 14.696 psia and 25 °C). 
This parameter is located in the lower middle of the display. It can be moved to 
the primary display by pushing the button below SCCM in this example. Your 
display may show a different unit of measure preceded by the letter S.

To get an accurate volumetric or mass flow rate, the gas being measured 
must be selected. See Gas Select, page 12. 

MENU: Pressing MENU switches the screen to the Select Menu display.

Flashing Error Message: An error message (MOV = mass overrange, 
VOV = volumetric overrange, POV = pressure overrange, TOV = 
temperature overrange) flashes when a measured parameter exceeds 
the range of the sensor. When any item flashes, neither the flashing 

parameter nor the mass flow measurement is accurate. Reducing the value of 
the flashing parameter to within specified limits will return the unit to normal 
operation and accuracy. 

If the unit does not return to normal operation contact Alicat.
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SELECT MENU
From Select Menu you can change the selected gas, interact with your RS-232 
settings or read manufacturer’s data.
Press the button next to the desired operation to bring that function to the screen.

An explanation for each screen can be found on the following pages.

RS232 
COMM

MFG
DATA

MAIN

MISC

GAS
SELECT

Miscellaneous
Communications Select

Main

Manufacturer Data

#C
+21.50

+0.000
CCM MAIN

TARE V

SCCM
Air

PSIA
+13.60

+0.000
SCCM

Gas Select

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109
MISC2

BACK
DEVICE
UNITS MAIN

MISC1

DOWN

CANCEL SELECT

PAGE

>Recent
  Standard
  Factory Custom
  COMPOSER User Mixes
  Bioreactor
  Breathing
  Chromatography
  Fuel

UP

BACK MAIN

UNIT ID
A

BAUD
19200

Select Menu

+ 0.00
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GAS SELECT
Gas Select allows you to set your 
device to up to 150 standard gases and 
mixes. You can also use COMPOSER to 
program and store up to 20 additional 
gas mixes.

Gas Select is accessed by pressing the 
button below GAS SELECT on the Select 
Menu display. 

To select a gas, use the UP and DOWN 
buttons to position the arrow in front of 
the desired gas category. 
»» Recent: Eight most recent selections
»» Standard: Gases and mixes standard 

on earlier Alicat instruments (page 27)
»» Factory Custom: Present only if customer 

requested gases were added at the factory
»» COMPOSER User Mixes: Gas mixes 

programmed by the user (page 13)
»» Bioreactor (page 32)
»» Breathing (page 33)
»» Chromatography (page 35)
»» Fuel (page 34)
»» Laser (page 34)
»» O2 Concentrator (page 35)
»» Pure Corrosive* (page 29)
»» Pure Non-Corrosive (page 28)
»» Refrigerant* (page 30)
»» Stack (page 35)
»» Welding (page 31)

Press PAGE to view a new page in the gas category list.

Press SELECT to view the gases in the selected category. Align the arrow with the 
desired gas. Press SET to record your selection and return to the MAIN display. 
The selected gas will be displayed on the screen.

* Pure Corrosive and Refrigerant gases are only available on S-Series instruments 
that are compatible with these gases.

Note: Gas Select may not be available on units ordered with a custom gas or blend.

See pages 28 -35 for a full list of gases in each category. 

DOWN

CANCEL SET

PAGE

>Recent
  Standard
  Factory Custom
  COMPOSER User Mixes
  Bioreactor
  Breathing
  Chromatography
  Fuel 

UP

DOWN

CANCEL SET

PAGE

> Fuel
  Laser
  O2 Concentrator
  Pure Corrosive
  Pure Non-Corrosive
  Refrigerant
  Stack
  Welding

UP
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COMPOSER
Composer allows you to program 
and save up to 20 custom gas mixes 
containing 2 to 5 component gases 
found in the gas lists (pages 28-35). The 
minimum resolution is 0.01%.

Composer is accessed by selecting 
COMPOSER User Mixes on the GAS 
SELECT display.

Press SET when the arrow is aligned 
with Add Mix.

Name the mix by pressing the UP and 
DOWN buttons for letters, numerals 
and symbols. 

CHANGE CASE – Toggles the letter 
case. Letters remain in selected case 
until CHANGE CASE is pushed again.

Press SET to save the name.

After naming the mix, press ADD GAS 
and select the gas category and the 
component gas.

Select the digit with arrow and adjust 
the % with the UP and DOWN buttons. 
Press set to save. Add up to 4 more 
gases as needed. The total must equal 
100% or an error message will appear.

GAS OPTNS allows you to adjust the 
percentage of the constituents or 
delete a gas from the mix. Gas mixes 
cannot be adjusted after they have 
been saved.

DOWN

CANCEL SET

>Add Mix: 20 Free
UP

DOWN

BACK/
CANCEL

CHANGE 
CASE SET

NEXT
LETTER

COMPOSER Mix name:

	 MyGas
	 ------˄

UP

ADD GAS

BACK/
CANCEL

CHANGE 
CASE SET

GAS 
OPTNS

COMPOSER Mix: MyGAS

      0.00% of Total

EDIT 
NAME
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Once the mix has been saved, you 
may press CREATE SIMILAR to 
compose an additional mix based 
on the mix you have just saved. 
This CREATE SIMILAR option is not 
available after leaving this screen.

Press CREATE NEW to add a 
completely new mix.

Press SELECT MIXTURE to bring the 
custom mix onto the MAIN display.

MAIN
SELECT 
MIXTURE

CREATE 
SIMILAR

COMPOSER USER MIX
MyGas

HAS BEEN SAVED

CREATE 
NEW

DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of Air:

	 50.00
	 ˄

UP DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of Ar Argon:

	 30.00
	 ˄

UP

DOWN

BACK/
CANCEL CLEAR SET

SELECT 
DIGIT

Percent of He Helium:

	 20.00
	 ˄

UP ADD GAS

CANCEL SAVE

GAS 
OPTNS

COMPOSER Mix: MyGAS
   50% Air
   30% AR Argon
   20% He Helium
 100.00%  Total

EDIT 
NAME
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COMMUNICATION SELECT
Access Communication Select by pressing 
the button above RS232 COMM on the 
Select Menu display. 
Unit ID – Valid unit identifiers are the 
letters A-Z and @. The identifier allows 
you to assign a unique address to each 
device so that multiple units can be 
connected to a single RS‑232 computer 
port. 
Press UNIT ID. Use the UP and DOWN 
buttons to change the Unit ID. Press SET to 
record the ID. Press Reset to return to the 
previously recorded Unit ID.
Any Unit ID change will take effect when 
Communication Select is exited.
If the symbol @ is selected as the Unit 
ID, the device will enter streaming mode 
when Communication Select is exited. 
See RS-232 Communications (page 19) for 
information about the streaming mode.
Baud – Both this instrument and your 
computer must send/receive data at the 
same baud rate. The default baud rate for 
this device is 19200 baud. 
Press the Select button until the arrow is 
in front of Baud. Use the UP and DOWN 
buttons  to select the baud rate that 
matches your computer. The choices are 
38400, 19200, 9600, or 2400 baud. 
Any baud rate change will not take effect 
until power to the unit is cycled.

UP

BACK RESET A SET

UNIT ID
C

DOWN

DOWN

BACK SET

BAUD UP

19200

BACK MAIN

UNIT ID
A

BAUD
19200

C



16

MISCELLANEOUS 
Miscellaneous is accessed by pressing the MISC button on the Select Menu display. 
Next select either MISC1 or MISC2. 

MISC1 will display as shown at left.
ZERO BAND refers to Display Zero Deadband. 
Zero deadband is a value below which the display 
jumps to zero. This deadband is often desired to 
prevent electrical noise from showing up on the 
display as minor flows or pressures that do not 
exist. Display Zero Deadband does not affect the 
analog or digital signal outputs.
ZERO BAND can be adjusted between 0 and 
6.3% of the sensor’s Full Scale (FS). 
Press ZERO BAND. Then use SELECT to choose 
the digit with the arrow and the UP and DOWN 
buttons to change the value. Press SET to record 
your value. Press CLEAR to return to zero.
Pressure Averaging and Flow Averaging may 
be useful to make it easier to read and interpret 
rapidly fluctuating pressures and flows. Pressure 
and flow averaging can be adjusted between 1 
(no averaging) and 256 (maximum averaging). 
These are geometric running averages where 
the number between 1 and 256 can be 
considered roughly equivalent to the response 
time constant in milliseconds. 

This can be effective at “smoothing” high frequency process oscillations such as 
those caused by diaphragm pumps. 
Press PRESS AVG. Then use SELECT to choose the digit with the arrow and the UP and 
DOWN buttons to change the value. Press SET to record your value. Press CLEAR to 
return to zero.

Press FLOW AVG. Then use SELECT to choose the 
digit with the arrow and the UP and DOWN buttons 
to change the value. Press SET to record your value. 
Press CLEAR to return to zero.
Setting a higher number will equal a smoother 
display. 
LCD CONTRAST: The display contrast can be 
adjusted between 0 and 31, with zero being the 
lightest and 31 being the darkest. Use the UP 
and DOWN buttons to adjust the contrast. Press 
SET when you are satisfied. Press CANCEL to 
return to the MISC display.

PRESS
AVG

BACK

LCD

CONTRAST MAIN

ZERO
BAND

FLOW
AVG

DOWN

CANCEL CLEAR SET

UP SELECT

0.0

>

DOWN

CANCEL RESET SET

UP

11
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DIAG
TEST

BACK MAIN

STP/
NTP

ROTATE 
DISP

STP
PRESS

MAIN

STP
TEMP

STP TEMP Display

CLEAR

DOWN

BACK/
CANCEL

Temperature: #C

SET

UP SELECT
DIGIT

25.0000

MISC2 will display as shown at left. 
STP/NPT refers to the functions that allow 
your selection of standard temperature and 
pressure conditions or normal temperature 
and pressure conditions. This feature is 
generally useful for comparison purposes to 
other devices or systems using different STP 
parameters. 
The STP menu is comprised of the STP TEMP 
and STP PRESS screens. 
STP TEMP allows you to select from 0C, 0F, K 
or 0Ra. The arrow position will automatically 
default to the currently stored value. 
The NTP menu is comprised of the NTP 
TEMP and NTP PRESS screens. 
Once a selection has been made and recorded 
using the SET button, a change acknowledgement 
message will be displayed on screen. 
Selecting MAIN will revert screen to the 
Main display. If the SET selection is already 
the currently stored value, a message 
indicating that fact will appear. 
STP PRESS enables you to select from a 
menu pressure settings. Use the UP/DOWN 
or PAGE buttons to view the settings.
The arrow position will automatically default 
to the currently stored value. 

Once a selection has been made and recorded using the SET button, a change 
acknowledgement message will be displayed on screen. 
Pressing SET again will revert screen to the Main display. If the SET selection is 
already the currently stored value, a message indicating that fact will appear. 

STP PRESS Display

101355.0

DOWN

BACK/
CANCEL SET

UP SELECT
DIGIT

Pressure: PaA

CLEAR
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DIAG TEST: This diagnostic screen displays 
the current register values configured by the 
factory, which is useful for noting factory 
settings prior to making any changes. It is 
also helpful for troubleshooting with Alicat 
customer service personnel.
Select the DIAG TEST button from the MISC2 
screen to view a list of select register values. 
Pressing the SCROLL button will cycle the 
display through the register screens. An 
example screen is shown at left.

Press ROTATE DISP and SET to Inverted 180° if your device is inverted. The 
display and buttons will rotate together.

BACK MAIN

SCROLL
R8:     AP Sig	 7871
R9:     Temp Sig	 39071
R10:    DP Side	 9986
R11:     DP Brdg	 36673
R13:    AP Brdg	 36673
R16:    Meter Func	 199
R18:    Power Up	 32768

DEVICE UNITS
Press DEVICE UNITS to access menus of 
units of measure for each parameter (and 
totalizer if so equipped).
Scroll to the desired unit and press select.
Once selected, you will see the message 
shown below. Verify that all connected 
devices expect the change.
See pages 36 and 37 for a full list of 
available units.

DOWN

DONE SELECT

Mass Flow
Volumetric Flow
Pressure
Temperature
Mass Totalizer
Totalizer Time

UP

DOWN

CANCEL SET

PAGE

SCCM
Scm3/h
Sm3/h
Sm3/d
Sin3/m
SCFH
NmL/s

UP
PRESSING SET WILL

AFFECT DISPLAY
AND SERIAL VALUES

VERIFY CONNECTED 
SERIAL DEVICES 

EXPECT THE CHANGE

SETCANCEL
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MANUFACTURER DATA
Manufacturer Data is accessed by pressing 
the MFG DATA button on the Select Menu 
display. 

The initial display shows the name and 
telephone number of the manufacturer.

Press MODEL INFO to show important 
information about your flow device 
including the model number, serial 
number, and date of manufacture. 

Press BACK to return to the MFG DATA 
display.

Push MAIN to return to the Main display.

MODEL
INFO

BACK MAIN

A L I C A T  S C I E N T I F I C

Ph    520-290-6060

Fax  520-290-0109

BACK MAIN

MODEL:  � M-100SCCM-D
SERIAL NO: � 100903
DATE  MFG:    � 3/7/2016
DATE  CAL:    � 3/9/2016
CAL  BY:  � DL
SW REV:  � 6v00.G
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RS-232 Output and Input 

Connect the male RS-232 DB9 port (See Fig. 1) of the PCU to the serial port of 
your computer or data logger. This will normally require a female/female DB9 
cable (included).

One of the most common ways to access the RS-232 output from your PCU is 
through a simple terminal program. Open your Hyperterminal RS-232 terminal 
program (installed under the “Accessories” menu on all Microsoft Windows 
operating systems). Select “Properties” from the file menu. Click on the 
“Configure” button under the “Connect To” tab. 

Be sure the program is set for: 19200 baud and an 8-N-1-None (8 Data Bits, No 
Parity, 1 Stop Bit, and no Flow Control) protocol. Under the “Settings” tab, make 
sure the Terminal Emulation is set to ANSI. 

Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line 
Feeds” Box is not checked, and that the “Append Line Feeds to Incoming Lines” 
box is checked. 

Those settings not mentioned here are normally okay in the default position. 
Type L, M or H to read data for the desired range. 

When the queried the window will fill with 6 columns of data representing 
the range (L=Low, M=Medium, H=High), absolute pressure, temperature, 
volumetric flow, mass flow, and selected gas respectively. Pressure units are psia, 
temperature units are Degrees C, volumetric flow units are Liters Per Minute, 
and mass flow units are Standard Liters Per Minute. The Low range is 0-2 slpm, 
the Medium range is 0-50 slpm, and the High range is 0-1000 slpm. 

L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR
L +014.70 +025.00 +02.004 +02.004 AIR

PCU Mass Flow Meter Data Format
(Low Range)

Note: On units with the totalizer function the sixth column will be the totalizer 
value, with gas select moving to a seventh column.



21

RS-232 Output and Input
Configuring HyperTerminal®:

1.	 Open your HyperTerminal® RS-232 terminal program (installed under the 
“Accessories” menu on all Microsoft Windows® operating systems).

2.	 Select “Properties” from the file menu.
3.	 Click on the “Configure” button under the “Connect To” tab. Be sure the 

program is set for: 19,200 baud (or matches the baud rate selected in the 
RS‑232 communications menu on the meter) and an 8-N-1-None (8 Data Bits, 
No Parity, 1 Stop Bit, and no Flow Control) protocol.

4.	 Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI 
or Auto Detect.

5.	 Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line 
Feeds” box is not checked and the “Echo Typed Characters Locally” box and 
the “Append Line Feeds to Incoming Lines” boxes are checked. Those settings 
not mentioned here are normally okay in the default position.

6.	 Save the settings, close HyperTerminal® and reopen it.

Streaming Mode

In the default Polling Mode, the screen should be blank except the blinking 
cursor. In order to get the data streaming to the screen, hit the “Enter” key 
several times to clear any extraneous information. Type “*@=@” followed by 
“Enter” (or using the RS-232 communication select menu, select @ as identifier 
and exit the screen). If data still does not appear, check all the connections and 
COM port assignments.

Streaming Mode – Advanced 

The streaming data rate is controlled by register 91. The recommended default rate 
of data provision is once every 50 milliseconds and this is suitable for most purposes. 

If a slower or faster streaming data rate is desired, register 91 can be changed to a 
value from 1 millisecond to 65535 milliseconds, or slightly over once every minute. 

Below approximately 40 milliseconds, data provision will be dependent upon 
how many parameters are selected. Fewer data parameters can be streamed 
more quickly than more. It is left to the user to balance streaming speed with 
number of parameters streamed. 

To read register 91, type “*r91” followed by “Enter”. 

To modify register 91, type “*w91=X”, where X is a positive integer from 1 to 
65535, followed by “Enter”. 

To return to the recommended factory default streaming speed, type “*w91= 50”.

Communication Set Up
http://www.alicat.com/support/instructional-videos/
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Tareing via RS-232:

Tare –Tareing (or zeroing) the flow meter provides it with a reference point for 
zero flow. This is a simple but important step in obtaining accurate measurements. 
It is good practice to “zero” the flow meter each time it is powered up. A unit may 
be Tared by following the instructions on page 9 or it may be Tared via RS-232 
input. 

To send a Tare command via RS-232, enter the following strings:

In Polling Mode:	 Address$$V<Enter>        (e.g. B$$V<Enter>)

Changing From Streaming to Polling Mode: 

When the meter is in the Streaming Mode, the screen is updated approximately 
10-60 times per second (depending on the amount of data on each line) so that 
the user sees the data essentially in real time. It is sometimes desirable, and 
necessary when using more than one unit on a single RS-232 line, to be able to 
poll the unit.

In Polling Mode the unit measures the flow normally, but only sends a line of data 
when it is “polled”. Each unit can be given its own unique identifier or address. 
Unless otherwise specified each unit is shipped with a default address of capital 
A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of 
information filling your screen:

1.	 Type *@=A followed by “Enter” (or using the RS-232 communication select 
menu, select A as identifier and exit the screen) to stop the streaming mode 
of information. Note that the flow of information will not stop while you 
are typing and you will not be able to read what you have typed. Also, the 
unit does not accept a backspace or delete in the line so it must be typed 
correctly. If in doubt, simply hit enter and start again. If the unit does not 
get exactly what it is expecting, it will ignore it. If the line has been typed 
correctly, the data will stop.

2.	 You may now poll the unit by typing A followed by “Enter”. This does an 
instantaneous poll of unit A and returns the values once. You may type A 
“Enter” as many times as you like. Alternately you could resume streaming 
mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

3.	 To assign the unit a new address, type *@=New Address, e.g. *@=B. Care 
should be taken not to assign an address to a unit if more than one unit is 
on the RS-232 line as all of the addresses will be reassigned. Instead, each 
should be individually attached to the RS-232 line, given an address, and 
taken off. After each unit has been given a unique address, they can all be 
put back on the same line and polled individually.
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Gas Select – The selected gas can be changed via RS-232 input. To change the 
selected gas, enter the following commands:

	 In Polling Mode:	 Address$$#<Enter>	    (e.g. B$$#<Enter>)

Where # is the number of the gas selected from the table below. Note that 
this also corresponds to the gas select menu on the flow controller screen (the 
Standard gas category is shown in the example below):

# GAS
0 Air Air
1 Argon     Ar
2 Methane    CH4
3 Carbon Monoxide    CO
4 Carbon Dioxide    CO2
5 Ethane    C2H6
6 Hydrogen    H2
7 Helium    He
8 Nitrogen    N2
9 Nitrous Oxide    N2O

10 Neon    Ne
11 Oxygen    O2
12 Propane    C3H8
13 normal-Butane    n-C4H10
14 Acetylene    C2H2
15 Ethylene    C2H4
16 iso-Butane i-C2H10
17 Krypton Kr
18 Xenon Xe
19 Sulfur Hexafluoride SF6
20 75% Argon / 25% CO2 C-25
21 90% Argon / 10% CO2 C-10
22 92% Argon / 8% CO2 C-8
23 98% Argon / 2% CO2 C-2
24 75% CO2 / 25% Argon C-75
25 75% Argon / 25% Helium HE-75
26 75% Helium / 25% Argon HE-25

27 90% Helium / 7.5% Argon / 2.5% CO2
(Praxair - Helistar® A1025) A1025

28 90% Argon / 8% CO2 / 2% Oxygen
(Praxair - Stargon® CS) Star29

29 95% Argon / 5% Methane P-5

For example, to select Propane, enter:  $$12<Enter>
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Creating and Deleting Gas Mixtures with COMPOSER™ using RS-232
Note: All commands must be prefixed with the unit ID letter. The unit should 
not be in streaming mode.
You may create and store up to 20 gas mixtures containing up to five 
constituent gases each. The constituent gases must be chosen from the existing 
list of gases installed on the device (which may vary model to model). Please 
see pages 27 – 34 for lists of gases and their corresponding gas numbers.
Create a Gas Mixture
To create a gas mixture, enter a single-line command according to the following formula: 
[Unit ID] GM [Gas Name] [Gas Mix Number] [Percent 1] [Gas Number 1] 
[Percent 2] [Gas Number 2] …etc. etc.
Notes: Do not type the brackets. There should be only one space between 
all items. Any percentages less than 1, should have a leading zero before 
the decimal (i.e. 0.25 for .25%). Trailing zeros are not necessary but they are 
allowed to help visualize the percentages on screen (as in the example). The 
sum of all percentages must be 100.00 otherwise an error will occur.
Here is an example of a three gas mixture for a new gas called “MyMix1” 
(50% O2, 49.5% Helium, and .5% Neon), stored in user location #236, where the 
unit ID of the device is “A”:

A GM MyMix1 236 50.00 11 49.50 7 0.50 10     <ENTER>
Gas Name: Name your mixture using a maximum of 6 characters.
Gas Mix Number: COMPOSER™ user mixes have Alicat gas numbers between 
236 and 255. You can assign any number in this range to your new mixture. If 
another mixture with the same number exists, it will be overwritten, even if 
that gas is currently selected on the unit. If you enter a 0 here, the new mix 
will be assigned the next available number between 236 and 255.
Percent 1: The percentage of the first constituent gas. The percentage of each 
constituent must be between 0.01 and 99.99. Values entered beyond two 
decimal points will be rounded to the nearest 0.01%.
Gas Number 1: The Alicat gas number of the first constituent gas.
Percent 2: The percentage of the second constituent gas. Values entered 
beyond two decimal points will be rounded to the nearest 0.01%.
Gas Number 2: The Alicat gas number of the second constituent gas.
Additional Gases: (Optional) The above pattern of [Percent] + [Gas Number] 
may be repeated for additional constituent gases (up to a total of five).
Upon success, the unit ID (if set) is returned followed by a space. The number 
of the gas mixture is then returned, followed by the percentages and names 
of each constituent in the mix. If the gas mix is not successfully created, a "?" 
is returned, and you must start over.

Delete a Gas Mixture
To delete a gas mixture, enter: 

[Unit ID]GD [Gas Number]: The number of the COMPOSER™ user mixture you 
wish to delete from the unit

Only COMPOSER™ user mixtures can be deleted with this command.
On success, the unit ID (if set) is returned followed by a space and the number of 
the gas deleted. If the gas is not successfully deleted, a "?" is returned.
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Data Format:
The data stream on the screen represents the flow parameters of the main mode 
in the units shown on the display. 
For mass flow meters, there are five columns of data representing pressure, 
temperature, volumetric flow, mass flow and the selected gas. 
The first column is absolute pressure (normally in psia), the second column is 
temperature (normally in °C), the third column is volumetric flow rate (in the 
units specified at time of order and shown on the display), and the fourth column 
is mass flow (also in the units specified at time of order and shown on the 
display). For instance, if the meter was ordered in units of scfm, the display on 
the meter would read 2.004 scfm and the last two columns of the output below 
would represent volumetric flow and mass flow in cfm and scfm respectively.

+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
+014.70 +025.00 +02.004 +02.004 Air
Pressure Temp Vol. Flow Mass Flow Gas

M-Series Mass Flow Meter Data Format
Note: On units with the totalizer function the fifth column will be the totalizer 
value, with gas select moving to a sixth column.

Collecting Data:
The RS-232 output updates to the screen many times per second. Very short-term 
events can be captured simply by disconnecting (there are two telephone symbol 
icons at the top of the HyperTerminal® screen for disconnecting and connecting) 
immediately after the event in question. The scroll bar can be driven up to the 
event and all of the data associated with the event can be selected, copied, and 
pasted into Microsoft® Excel® or other spreadsheet program as described below.
For longer term data, it is useful to capture the data in a text file. With the desired 
data streaming to the screen, select “Capture Text” from the Transfer Menu. 
Type in the path and file name you wish to use. Push the start button. When the 
data collection period is complete, simply select “Capture Text” from the Transfer 
Menu and select “Stop” from the sub-menu that appears.
Data that is selected and copied, either directly from HyperTerminal® or from 
a text file can be pasted directly into Excel®. When the data is pasted it will all 
be in the selected column. Select “Text to Columns...” under the Data menu in 
Excel® and a Text to Columns Wizard (dialog box) will appear. Make sure that 
“Fixed Width” is selected under Original Data Type in the first dialog box and 
click “Next”. In the second dialog box, set the column widths as desired, but the 
default is usually acceptable. Click on “Next” again.  In the third dialog box, make 
sure the column data format is set to “General”, and click “Finish”. This separates 
the data into columns for manipulation and removes symbols such as the plus 
signs from the numbers. Once the data is in this format, it can be graphed or 
manipulated as desired.      For extended term data capture see page 26.
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Sending a Simple Script File to HyperTerminal®
It is sometimes desirable to capture data for an extended period of time. Standard 
streaming mode information is useful for short term events, however, when 
capturing data for an extended period of time, the amount of data and thus the 
file size can become too large very quickly. Without any special programming 
skills, you can use HyperTerminal® and a text editing program such as Microsoft® 
Word® to capture text at defined intervals.
1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS 
Word, you can tell how many lines you have by the line count at the bottom of the 
screen. The number of lines will correspond to the total number of times the flow 
device will be polled, and thus the total number of lines of data it will produce.
For example:	 A

	 A
	 A
	 A
	 A
	 A
will get a total of six lines of data from the flow meter, but you can 
enter as many as you like.

The time between each line will be set in HyperTerminal.
4. When you have as many lines as you wish, go to the File menu and select save. 
In the save dialog box, enter a path and file name as desired and in the “Save as 
Type” box, select the plain text (.txt) option. It is important that it be saved as a 
generic text file for HyperTerminal to work with it.
5. Click Save.
6. A file conversion box will appear. In the “End Lines With” drop down box, select 
CR Only. Everything else can be left as default.
7. Click O.K.
8. You have now created a “script” file to send to HyperTerminal. Close the file 
and exit the text editing program.
9. Open HyperTerminal and establish communication with your flow device as 
outlined in the manual.
10. Set the flow device to Polling Mode as described in the manual. Each time you 
type A<Enter>, the meter should return one line of data to the screen.
11. Go to the File menu in HyperTerminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
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14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell 
the program how often to read a line from the script file you’ve created. 1000 
milliseconds is one second, so if you want a line of data every 30 seconds, you 
would enter 30000 into the box. If you want a line every 5 minutes, you would 
enter 300000 into the box.
15. When you have entered the value you want, click on OK and OK in the 
Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” file you created.
18. Click Open.
19. The program will begin “executing” your script file, reading one line at a time 
with the line delay you specified and the flow device will respond by sending one 
line of data for each poll it receives, when it receives it.
You can also capture the data to another file as described in the manual under 
“Collecting Data”. You will be simultaneously sending it a script file and capturing 
the output to a separate file for analysis.

Operating Principle

All M-Series Gas Flow Meters (and MC Series Gas Flow Controllers) are based on the 
accurate measurement of volumetric flow. The volumetric flow rate is determined 
by creating a pressure drop across a unique internal restriction, known as a Laminar 
Flow Element (LFE), and measuring differential pressure across it. The restriction is 
designed so that the gas molecules are forced to move in parallel paths along the 
entire length of the passage; hence laminar (streamline) flow is established for the 
entire range of operation of the device. Unlike other flow measuring devices, in 
laminar flow meters the relationship between pressure drop and flow is linear. 

Please visit the Alicat web site for a detailed explanation this principle.
http://www.alicat.com/technical-information/theory-of-operation/

STANDARD GAS DATA TABLES: Those of you who have older Alicat products 
may notice small discrepancies between the gas property tables of your old and 
new units. Alicat Scientific, Inc. has incorporated the latest data sets from NIST 
(including their REFPROP 9 data where available) in our products’ built-in gas 
property models. Be aware that the calibrators that you may be using may be 
checking against older data sets such as the widely distributed Air Liquide data. 
This may generate apparent calibration discrepancies of up to 0.6% of reading on 
well behaved gases and as much as 3% of reading on some gases such as propane 
and butane, unless the standard was directly calibrated on the gas in question. 
As the older standards are phased out, this difference in readings will cease 
to be a problem. If you see a difference between the Alicat meter and your in-
house standard, in addition to calling Alicat Scientific at (520) 290-6060, call the 
manufacturer of your standard for clarification as to which data set they used in 
their calibration. This comparison will in all likelihood resolve the problem.
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Supported Units: This device supports many different units. You may select the desired units (see 
page 28). Note that only units appropriate to this device are available for selection.

Pressure Units
Absolute Gauge Differential Notes

PaA PaG PaD pascal
hPaA hPaG hPaD hectopascal
kPaA kPaG kPaD kilopascal
MPaA MPaG MPaD megapascal
mbarA mbarG mbarD millibar
barA barG barD bar

g/cm2A g/cm2G g/cm2D gram force per square centimeter
kg/cmA kg/cmG kg/cmD kilogram force per square centimeter

PSIA PSIG PSID pound force per square inch
PSFA PSFG PSFD pound force per square foot

mTorrA mTorrG mTorrD millitorr
torrA torrG torrD torr

mmHgA mmHgG mmHgD millimeter of mercury at 0 C
inHgA inHgG inHgD inch of mercury at 0 C

mmH2OA mmH2OG mmH2OD millimeter of water at 4 C (NIST conventional)
mmH2OA mmH2OG mmH2OD millimeter of water at 60 C
cmH2OA cmH2OG cmH2OD centimeter of water at 4 C (NIST conventional)
cmH2OA cmH2OG cmH2OD centimeter of water at 60 C
inH2OA inH2OG inH2OD inch of water at 4 C (NIST conventional)
inH2OA inH2OG inH2OD inch of water at 60 C

atm atmosphere
m asl meter above sea level (only in /ALT builds)
ft asl foot above sea level (only in /ALT builds)

V volt; no conversions are performed to or from other units
count count count setpoint count, 0 – 64000

% % % percent of full scale

Flow Units
Volumetric Standard Normal Notes

uL/m SuL/m NuL/m microliter per minute
mL/s SmL/s NmL/s milliliter per second

mL/m SmL/m NmL/m milliliter per minute
mL/h Sml/h NmL/h milliliter per hour

L/s SL/s NL/s liter per second
LPM SLPM NLPM liter per minute
L/h SL/h NL/h liter per hour

US GPM US gallon per minute
US GPH US gallon per hour

CCS SCCS NCCS cubic centimeter per second
CCM SCCM NCCM cubic centimeter per minute

cm3/h Scm3/h Ncm3/h cubic centimeter per hour
m3/m Sm3/m Nm3/m cubic meter per minute
m3/h Sm3/h Nm3/h cubic meter per hour
m3/d Sm3/d Nm3/d cubic meter per day
in3/m Sin3/m cubic inch per minute
CFM SCFM cubic foot per minute
CFH SCFH cubic foot per hour

kSCFM 1000 cubic feet per minute
count count count setpoint count, 0 – 64000

% % % percent of full scale
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True Mass Flow Units
Label Notes
mg/s milligram per second

mg/m milligram per minute
g/s gram per second

g/m gram per minute
g/h gram per hour

kg/m kilogram per minute
kg/h kilogram per hour
oz/s ounce per second

oz/m ounce per minute
lb/m pound per minute
lb/h pound per hour

These can be used for mass flow on gas devices. These can also be used for volumetric flow on liquid 
devices calibrated in one of these units (liquid density is not yet supported).

Totalizer Units
Volumetric Standard Normal Notes

uL SuL NuL microliter
mL SmL NmL milliliter
L SL NL liter

US GAL US gallon
cm3 Scm3 Ncm3 cubic centimeter
m3 Sm3 Nm3 cubic meter
in3 Sin3 cubic inch
ft3 Sft3 cubic foot

kSft3 1000 cubic feet

uP micropoise, a measure of viscosity; no conversions are performed to or from 
other units

Total Mass Units
Label Notes

mg milligram
g gram

kg kilogram
oz ounce
lb pound

These can be used for totalized mass on gas devices. These can also be used for totalized 
volume on liquid devices calibrated in one of these units (liquid density is not yet supported).

Temperature Units
Label Notes

°C degree Celsius
°F degree Farenheit
K Kelvin
°R degree Rankine

Time Units
Label Notes
h:m:s Displayed value is hours:minutes:seconds

ms millisecond
s second

m minute
hour hour
day day
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TROUBLESHOOTING

Display does not come on or is weak.
Check power and ground connections. 

Flow reading is approximately fixed either near zero or near full scale 
regardless of actual line flow.
Differential pressure sensor may be damaged. Avoid installations that can 
subject sensor to pressure drops in excess of 10 psid. A common cause of this 
problem is instantaneous application of high‑pressure gas as from a snap acting 
solenoid valve upstream of the meter. If you suspect that your pressure sensor 
is damaged please discontinue use of the meter and contact Alicat.

Displayed mass flow, volumetric flow, pressure or temperature is flashing and 
message MOV, VOV, POV or TOV is displayed:
Our flow meters and controllers display an error message (MOV = mass 
overrange, VOV = volumetric overrange, POV = pressure overrange, TOV = 
temperature overrange) when a measured parameter exceeds the range of the 
sensors in the device. When any item flashes on the display, neither the flashing 
parameter nor the mass flow measurement is accurate. Reducing the value of 
the flashing parameter to within specified limits will return the unit to normal 
operation and accuracy. If the unit does not return to normal contact Alicat.

Meter reads negative flow when there is a confirmed no flow condition.
This is an indication of an improper tare. If the meter is tared while there is flow, 
that flow is accepted as zero flow. When an actual zero flow condition exists, 
the meter will read a negative flow. Simply re-tare at the confirmed zero flow 
condition. Also note that while the meter is intended for positive flow, it will 
read negative flow with reasonable accuracy, but not to the full scale flow rate 
(it is not calibrated for bi-directional flow) and no damage will result.

Meter does not agree with another meter I have in line.
Volumetric meters are affected by pressure drops. Volumetric flow meters 
should not be compared to mass flow meters. Mass flow meters can be 
compared against one another provided there are no leaks between the two 
meters and they are set to the same standard temperature and pressure. Both 
meters must also be calibrated (or set) for the gas being measured. M-Series 
mass flow meters are normally set to Standard Temperature and Pressure 
conditions of 25° C and 14.696 psia. Note: it is possible to special order meters 
with a customer specified set of standard conditions. The calibration sheet 
provided with each meter lists its standard conditions. 
When performing this comparison it is best to use the smallest transition 
possible between the two devices. Using small transitions will minimize lag and 
dead volume.
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Flow flutters or is jumpy.
The meters are very fast and will pick up any actual flow fluctuations such as from a 
diaphragm pump, etc. Also, inspect the inside of the upstream connection for debris 
such a Teflon tape shreds. 
Note: PCU meters feature a programmable geometric running average (GRA) that 
can aid in allowing a rapidly fluctuating flow to be read (see “Pressure Averaging” and 
“Flow Averaging” page 16).

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter, 
as voltage drops in the wires increase with distance. Using heavier gauge wires, 
especially in the ground wire, can reduce this effect.

RS-232 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the 
port on the computer to which the meter is connected is active. Confirm that 
the port settings are correct per the RS-232 instructions in this manual (Check 
the RS-232 communications select screen for current meter readings). Close 
Hyperterminal® and reopen it. Reboot your PC. See pages 20 - 26 for more 
information on RS-232 signals and communications.

Slower response than specified.
PCU Meters feature a programmable Geometric Running Average (GRA). 
Depending on the full scale range of the meter, it may have the GRA set 
to enhance the stability/readability of the display, which would result in 
slower perceived response time. Please see “Pressure Averaging” and “Flow 
Averaging” on page 16.

Jumps to zero at low flow.
PCU Meters feature a programmable zero deadband. The factory setting is 
usually 0.5% of full scale. This can be adjusted between NONE and 6.3% of full 
scale. See page 16.

Discrepancies between old and new units.
Please see “Standard Gas Data Tables” explanation on page 27.
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Maintenance and Recalibration

General: Portable Calibration Units require minimal maintenance. They have no 
moving parts. The single most important thing that affects the life and accuracy 
of these devices is the quality of the gas being measured. The meters are 
designed to measure CLEAN, DRY, NON-CORROSIVE gases.

Moisture, oil and other contaminants can affect the laminar flow elements. 

Recalibration: The recommended period for recalibration is once every year. A 
label located on the PCU lists the most recent calibration date. The PCU should 
be returned to the factory for recalibration within one year from the listed date. 
Before calling to schedule a recalibration, please note the serial number on the 
back of the meter. The Serial Number, Model Number, and Date of Manufacture 
are also available on the Model Info display (page 19).

Cleaning: PCU meters require no periodic cleaning. If necessary, the outside of 
the meter can be cleaned with a soft dry cloth. Avoid excess moisture or solvents.

For repair, recalibration or recycling of this product contact:

Alicat Scientific, Inc.
7641 N Business Park Drive

Tucson, Arizona 85743
USA

Phone: 520-290-6060
Fax: 520-290-0109

e-mail: info@alicat.com
Web site: www.alicat.com
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Option: Totalizing Mode - Meters
Meters can be purchased with the Totalizing Mode option. This option adds an 
additional mode screen that displays the total flow (normally in the units of the 
main flow screen) that has passed through the device since the last time the 
totalizer was cleared. The Totalizing Mode screen is accessed by pushing the 
TOTAL/TIMER button on the MAIN display. 

TOTAL/TIMER: Pushing the TOTAL/TIMER button 
will cycle the large numbers on the display 
between total mass and time elapsed.
Rollover – The customer can also specify at the 
time of order what the totalizer is to do when 
the maximum count is reached. The following 
options may be specified:
No Rollover – When the counter reaches the 
maximum count it stops counting until the 
counter is cleared.
Rollover – When the counter reaches the 
maximum count it automatically rolls over to 

zero and continues counting until the counter is cleared.
Rollover with Notification – When the counter reaches the maximum count 
it automatically rolls over to zero, displays an overflow error, and continues 
counting until the counter is cleared.
TOTAL MASS: The counter can have as many as seven digits. At the time of order, 
the customer must specify the range. This directly affects the maximum count. For 
instance, if a range of 1/100ths of a liter is specified on a meter which is totalizing in 
liters, the maximum count would be 99999.99 liters. If the same unit were specified 
with a 1 liter range, the maximum count would be 9999999 liters.
ELAPSED TIME: The small numbers below the mass total show the elapsed time 
since the last reset in hours, minutes and seconds. The maximum measurable 
elapsed time is 9999 hours 59 minutes 59 seconds. The hours count resets when 
RESET is pushed, an RS-232 clear is executed or on loss of power. Press TOTAL/
TIMER to show this as the primary display.
SETPT: Pushing SETPT will allow you to change the controller's set-point.
RESET – The counter can be reset to zero at any time by pushing the RESET 
button. To clear the counter via RS-232, establish serial communication with the 
meter or controller as described in the RS-232 or RS-485 section of the manual. 
To reset the counter, enter the following commands:

In Polling (addressable) Mode:  Address$$T <Enter>  (e.g. B$$T <Enter>)

SETPT
+123.4

MENU/
MAIN

SCCM
+123.4

TOTAL/
TIMER

BATCH RESET

50:56 h:m:s
+123.45

Scm3
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Accessory: Flow Vision™ SC Software
Flow Vision™ SC is an intuitive software interface to help your test 
cycles run smoother and shorten your engineering time! 

Flow Vision™ SC lets you connect to and communicate with multiple Alicat 
units simultaneously. Now you can view virtual displays, control tabs, charts 
and data lines from every connected Alicat device on the same screen.

Flow Vision™ SC supports all RS-232 and RS-485 Serial communication 
functions, including: gas selection, tareing, set‑point control, valve tuning 
and flow averaging.
Session Saving: Save and reload your configuration data with confidence. 
Script Building: Create scripts to adjust a controller’s set-point value at 
variable specified time intervals.
Charting: Chart as many parameters as you want off as many devices as you 
want, with color coding, zooming, and printing functionality.
Alarms: Create software alarms that will notify you of given parameter conditions.
Data Capture & Logging: Capture and log data to either a .csv file or a .txt file. 
Improved Data Logging and Data Log File Splitting for easy to manage data.

Accessory: Flow Vision™ MX Software
Alicat’s New Flow Vision™ MX software gives you an easy way to do  
GAS BLENDING using Alicat Mass Flow Controllers and your own PC. 

Flow Vision™ MX software is a simple way to connect up to six Alicat 
mass flow controllers and create your own gas mix concentrations.

Using our inexpensive BB9-USB and a single USB connection you can: 

•	 Create your own gas blends 
•	 Adjust flow rates 
•	 Save your specific blend formulas.

All the controllers can be powered through the BB9-USB with a single 
power supply.

Just connect your unique gases to each controller, select the gas type either 
locally on the controller or through Flow Vision™ MX, manifold the flow 
outputs and create your gas mix.
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Accessories
Part Number Description

FLOWVISIONSC Flow Vision™ SC software for interface with all Alicat instruments

FLOWVISIONMX Flow Vision™ MX software for gas blending

BB9 9 position Multi-Drop Box

BB9-I 9 position Multi-Drop Box, Industrial connectors

PVPS24U Universal 100-240 VAC to 24 Volt DC Power Supply Adapter

PS24VHC High current power supply for BB9 use with Large Valve Controllers

PCASE Industrial carry and storage case for portable meters/gauges

DC-61 8 Pin Male Mini-DIN connector cable, single ended, 6 foot length

DC-251 8 Pin Male Mini-DIN connector cable, single ended, 25 foot length

DC-301 8 Pin Male Mini-DIN connector cable, single ended, 30 foot length

DC-501 8 Pin Male Mini-DIN connector cable, single ended, 50 foot length

DC-751 8 Pin Male Mini-DIN connector cable, single ended, 75 foot length

DC-6RT 8 Pin Male Right Angle Mini-Din Cable, single ended, 6 foot length
DC-62 8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
DC-252 8 Pin Male Mini-DIN connector cable, double ended, 25 foot length
DC-502 8 Pin Male Mini-DIN connector cable, double ended, 50 foot length

DC-602 8 Pin Male Mini-DIN connector cable, double ended, 60 foot length

MD8DB9 8 Pin Male Mini-DIN to DB9 Female Adapter, 6 foot length

DBC-251 DB15 cable, single ended, 25 foot length

510199 DB9 cable, double-ended female, 3 meter length

IC10 Industrial cable, 6 Pin, single ended, 10 foot length

IC10-18G 18 gauge industrial cable, 6 Pin, single ended, 10 foot length

IC20 Industrial cable, 6 Pin, single ended, 20 foot length

IC24-18G 18 gauge industrial cable, 6 Pin, single ended, 24 foot length

IC50 Industrial cable, 6 Pin, single ended, 50 foot length

IC-102 Industrial cable, 6 pin double ended, 10 foot length

USB-RS232 RS-232 to USB Converter
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MNPT to Compression Fittings
10-32 - 1/8” SS-200-1-0157
10-32 - 1/4” SS-400-1-0256
1/8” - 1/8” SS-200-1-2
1/8” - 1/4” SS-400-1-2
1/8” - 3/8” SS-600-1-2
1/8” - 1/2” SS-810-1-2
1/8” - 3mm SS-3M0-1-2
1/8” - 4mm SS-4M0-1-2
1/8” - 6mm SS-6M0-1-2
1/8” - 8mm SS-8M0-1-2

1/8” - 12mm SS-12M0-1-2
1/4” - 1/8” SS-200-1-4
1/4” - 1/4” SS-400-1-4
1/4” - 3/8” SS-600-1-4
1/4” - 1/2” SS-810-1-4
1/4” - 3mm SS-3M0-1-4
1/4” - 4mm SS-4M0-1-4
1/4” - 6mm SS-6M0-1-4
1/4” - 8mm SS-8M0-1-4

1/4” - 12mm SS-12M0-1-4
1/2” - 1/8” SS-200-1-8
1/2” - 1/4” SS-400-1-8
1/2” - 3/8” SS-600-1-8
1/2” - 1/2” SS-810-1-8
1/2” - 3/4” SS-1210-1-8
1/2” - 6mm SS-6M0-1-8
1/2” - 8mm SS-8M0-1-8

1/2” - 12mm SS-12M0-1-8
1/2” - 16mm SS-16M0-1-8
3/4” - 1/4” SS-400-1-12
3/4” - 1/2” SS-810-1-12
3/4” - 3/4” SS-1210-1-12

3/4” - 12mm SS-12M0-1-12
3/4” - 16mm SS-16M0-1-12

Filters & Elements FNPT-MNPT
10-32 5μ 510053

10-32 20μ 510054
1/8” 20μ ILF-1/8-20
1/4” 40μ ILF-1/4-40
1/2” 40μ ILF-1/2-40*
3/4” 40μ ILF-3/4-40*

20μ element ILFE20
40μ element ILFE40
40μ element ILFE40L*

Filters & Elements FNPT-FNPT*
10-32 5μ CF-303-20-316

*requires MNPT to MNPT coupler to 
interface with Alicat flow bodies

10-32 Male UNF to 1/8 FNPT Adapter

410133

Male M5 (10-32) Buna-N O-ring face seal 
to 1/8”Female NPT

Accessories
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Information for Alicat TFT (Color Display) Instruments
Alicat TFT (color display) instruments have a high contrast back-lit LCD display. 
TFT instruments operate in accordance with Alicat standard operating instructions 
for our monochrome menus and displays with the following differences. 

Multi-Color Display Color Codes:

GREEN: Green labels identify the parameters and/or adjustments 
associated with the button directly above or below the label.

WHITE: The color of each parameter is displayed in white while operating 
under normal conditions.

RED: The color of a parameter is displayed in red when operating 
conditions for that parameter exceed 128% of the device’s specifications.

YELLOW: Yellow is the equivalent of the selection arrow on the 
monochrome display.

LCD Contrast: 
LCD contrast is ranged from 0 to 11 on color displays with 11 being the greatest 
contrast.

Display On/Off: 
Pushing the button under the Alicat name will turn the device display on or off. 
This feature is not available on monochrome displays.

NOTE: A color display will result in significantly reduced battery life in 
PCU and portable instruments. 

Technical Data for TFT (Color Display) Meters, Gauges and Controllers

The following specifications are applicable to Alicat TFT (color display) meters, 
gauges and controllers only. All other operating specifications are shown in the 
Technical Data page for standard Alicat instruments. All standard device features 
and functions are available and operate in accordance with the Alicat operating 
manual provided with the device. 

Specification Meter  or 
Gauge

Small Valve 
Controller

Large Valve 
Controller

Supply Voltage 7 to 30 Vdc 12 to 30 Vdc 24 to 30 Vdc
Supply Current 80 mA @ 12Vdc

70 mA @ 24Vdc
290 mA @ 12Vdc
200 mA @ 24Vdc

780 mA @ 
24Vdc
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Technical Data for Alicat PCU Mass Flow Meters
M Series 0 to 0.5 sccm Full Scale through 0 to 1500 slpm Full Scale
Whisper 0 to 0.5 sccm Full Scale through 0 to 250 slpm Full Scale

Standard Operating Specifications (Contact Alicat for available options)
Performance PCU Mass Flow Meter

Accuracy at calibration conditions 
after tare ± (0.8% of Reading + 0.2% of Full Scale)

High Accuracy at calibration conditions 
after tare

± (0.4% of Reading + 0.2% of Full Scale)
High Accuracy option not available for units ranged under 5 sccm or over 500 slpm.

Repeatability ± 0.2% Full Scale

Zero Shift and Span Shift 0.02% Full Scale / ºCelsius / Atm

Operating Range / Turndown Ratio 0.5% to 100% Full Scale / 200:1 Turndown

Maximum Measurable Flow Rate 128% Full Scale

Typical Response Time 10 ms (Adjustable) 

Warm-up Time < 1 Second

Communications / Power PCU Mass Flow Meter
Monochrome LCD Display with 

integrated touchpad Simultaneously displays Mass Flow, Volumetric Flow, Pressure and Temperature

Digital Output Signal1 RS-232 Serial 

Electrical Supply Two 9 Vdc batteries 9-20 Vdc wall outlet adaptor minimum 150 mA

1. The Digital Output Signal communicates Mass Flow, Volumetric Flow, Pressure and Temperature 

Operating Conditions PCU Mass Flow Meter
Mass Reference Conditions (STP) 25 ºC & 14.696 psia (standard — others available on request)

Operating Temperature −10 to +50 ºCelsius

Humidity Range (Non–Condensing) 0 to 100%

Maximum Pressure M Series: 145 psig Whisper: 50 psig1

Ingress Protection IP40

Wetted Materials
303 & 302 Stainless Steel, Viton®, Heat Cured Silicone Rubber, Glass Reinforced 
Polyphenylene Sulfide, Heat Cured Epoxy, Aluminum, Gold, Silicon, Glass.
 If your application demands a different material, please contact Alicat.

1. Do Not subject a WHISPER Differential Pressure sensor to upstream-downstream pressure differentials exceeding 15 psid. 

FS Flow M-Series Meter Pressure Drop at 
FS Flow  (psid)* 

0.5 sccm to 1 sccm 1.0

2 sccm to 50 sccm 1.0

100 sccm to 20 slpm 1.0
50 slpm 2.0
100 slpm 2.5
250 slpm 2.1
500 slpm 4.0
1000 slpm 6.0
1500 slpm 9.0

*Venting to atmosphere

Range Specific Specifications

No charge for alternate full scale ranges to increase accuracy (e.g. 2.5 slpm) or alternate units of measure (e.g. 133 scfh).

Full Scale range applies for all gases and mixtures in the tables (pages 28-35).

FS Flow Whisper Meter Pressure Drop at 
FS Flow (psid)* 

0.5 sccm to 2 sccm 0.06
5 sccm to 20 sccm 0.07

50 sccm 0.07
100 sccm to 200 sccm 0.06

500 sccm 0.07
1 slpm to 5 slpm 0.07

10 slpm 0.08
20 slpm 0.25
40 slpm 0.12
50 slpm 0.14
100 slpm 0.24
250 slpm 0.60

*Venting to atmosphere

Weight: 12 - 20 lb depending on configuration 

PCU Case Dimensions: 16” L x 13” W x 7” H	

Process Connections: 1/8”, 1/4”, 3/8” or 1/2” push-connect style tubing fittings



Serial Number: ______________________
Model Number: _________________________
Notice: Alicat Scientific, Inc. reserves the right to make any changes and improvements to the products 
described in this manual at any time and without notice. This manual is copyrighted. This document may 
not, in whole or in part, be copied, reproduced, translated, or converted to any electronic medium or 
machine readable form, for commercial purposes, without prior written consent from the copyright holder.
Note: Although we provide assistance on Alicat Scientific products both personally and through our 
literature, it is the complete responsibility of the user to determine the suitability of any product to their 
application.

Limited Lifetime Warranty
Alicat Scientific, Inc. warrants to the original purchaser (hereinafter referred to as “Buyer”) that 
instruments manufactured by Alicat Scientific (hereinafter referred to as “Product”) shall be free from 
defects in materials and workmanship for the life of the Products.
Under this warranty, the Products will be repaired or replaced at manufacturer’s option, without charge for 
parts or labor when the Product is carried or shipped prepaid to the factory together with proof of purchase.
The foregoing shall constitute the exclusive and sole remedy in lieu of other remedies of the Buyer for 
any breach by Alicat Scientific of this warranty to the maximum extent permitted by law.
This warranty does not apply to any Product which has not been installed or used in accordance with 
the Product operation and installation specifications provided to Buyer verbally or in writing by Alicat 
Scientific for the proper and normal use of the Product.
Buyer agrees hereunder that Alicat reserves the right to void any warranty, written or implied, if upon 
Alicat’s examination of Product shall disclose to Alicat’s satisfaction that the Product failure was due 
solely, or in part, to accident, misuse, neglect, abuse, alteration, improper installation, unauthorized 
repair or improper testing by Buyer or agent of Buyer.
Alicat Scientific shall not be liable under any circumstances for indirect, special, consequential, or 
incidental damages in connection with, or arising out of, the sale, performance, or use of the Products 
covered by this warranty.
Alicat Scientific does not recommend, warrant or assume responsibility for the use of the Products in life 
support applications or systems.
Alicat’s warranties as herein above set forth shall not be enlarged, diminished or affected by, and no 
obligation or liability shall arise or grow out of Alicat’s rendering of technical advice in connection with 
Buyer’s order of the Products furnished hereunder.
If Product becomes obsolete, Alicat Scientific, at its own discretion, reserves the right to repair the 
Product with available replacement parts or upgrade the Product to a current, commercially available 
version of the original Product.  Should upgrading the Product be deemed necessary by Alicat, Buyer 
hereby agrees to pay an upgrade fee equal to seventy percent of the retail value of the replacement 
Product.  Alicat Scientific hereunder makes no claim that replacement Products will look, function or 
operate in the same or similar manner as the original product.
When a Product is returned to Alicat Scientific for recalibration this service is considered normal 
preventative maintenance.  Recalibration of Product shall not be treated as a warranty service unless 
recalibration of Product is required as the result of repairs to Product pursuant to this Warranty.  Failure 
of Buyer to send Product to Alicat Scientific for recalibration on a yearly basis after a period of 36 months 
from date of manufacture will remove any and all obligations regarding repair or replacement of Product 
as outlined by this Warranty to Buyer from Alicat Scientific.
This Warranty is in lieu of all other relevant warranties, expressed or implied, including the implied 
warranty of merchantability and the implied warranty of fitness for a particular purpose, and any warranty 
against infringement of any patent.
Continued use or possession of Products after expiration of the applicable warranty period stated above 
shall be conclusive evidence that the warranty is fulfilled to the full satisfaction of Buyer. 
Alicat makes no warranty as to experimental, non-standard or developmental Products.
Accessories purchased from Alicat are not covered by this warranty.

Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 2006/95/EC and the EMC Directive 
2004/108/EC and carries the CE Marking accordingly. Contact the manufacturer for more information.



SC
FM

1.00
=

28.3160
SLPM

SLPM
100.00

=
3.5316

SC
FM

SC
FH

1.00
=

0.4719
SLPM

SLPM
100.00

=
211.9093

SC
FH

SC
IM

100.00
=

1.6390
SLPM

SLPM
1.00

=
61.0128

SC
IM

SC
IH

1000.00
=

0.2732
SLPM

SLPM
1.00

=
3660.7688

SC
IH

Flow
 C

onversions:

alicat.com
 	

 The Fastest Flow
 C

ontroller C
om

pany in the W
orld!

7641 N
 B

usiness Park D
rive

Tucson A
Z 85743 U

SA
Phone: 888-290-6060	

Fax: 520-290-0109

#
G

as
A

bsolute
Viscosity*

25°C
 

D
ensity **
25°C

14.696PSIA

C
om

pressibility
 25°C

14.696PSIA
0

A
ir 

A
ir

184.8989
1.1840
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N
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